
Q: Is the end of cartography nigh? Will Tom Tom
Mapshare catch on? [comment on an article in PC-
PRO entitled “end of the road for professional
mapping” http://tinyurl.com/22jsv8]

A: … as with electronic books which just don’t give the
same satisfaction when curled up in a chair or under the
bed covers electronic mapping will never (for me)
entirely replace the tactile experience of reading or
folding a map.

A: I am not sure if a dataset created with no quality
control (not to mention by the general public) is of much
value … I would hate to be the subject of some joker.
And I wonder how the system deals with a potential
dispute – who is “right”?

A: Well, Wikipedia is the classic example of how
community input works – or doesn’t. The original article,
though, I think was pretty crass, certainly woefully under-

informed. Most of all, the author either didn’t appreciate,
or chose to ignore, that cartography is not simply about
surveying. If map data becomes easier and cheaper to
obtain, that’s good news for the rest of us, who won’t
have to buy it from the OS any more. 
And as for “No competitor has yet even announced a
comparable system” – er, OpenStreetMap.

A: I believe the introduction of this facility will only go
to highlight the benefits of using a Cartographer in
mapping. In other words, you’ll soon see the difference in
quality between a cartographically rendered map and an
amateur’s one.
To start, I must stress that cartography is about visual
communication, based on skills that are acquired through
training and experience. Simply inputting data into a
visual database GIS/SatNav, whatever, does not make a
cartographer. Capturing/inputting raw geo-referenced data
is only one part of the process. Cartographers translate
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this raw visual data into a format that is clear, easy and
accurate for the user to read, understand and utilise,
without the fear of error or confusion.
I feel that hobbyist mapping is a great idea, and is one of
the most valuable ways to get people interested and
involved in this field. I for one, enjoy using GPS devices
and making my own personal maps and sharing data on
existing mapping websites. However, this hobby must not
be confused with serious mapping that potentially holds
great responsibilities for the end user.
For example. It’s well known how people can easily
discard common sense when using SatNav devices in
their cars, and follow the instructions provided, regardless
of what goes on around them. We are also aware of the
flaws concerned with open access data input servers and
sites. All are susceptible to erroneous input and even
worse, biased and malicious use. The reliability of
Wikipedia is one classic example. ‘Map Share’ holds no
one accountable for it’s development and data in this
context. Unlike a commercial organisation that relies on
it’s integrity and accuracy. In other words, ‘formally
published’ mapping data will be inherently safer and
more accurate to use than ‘Map Share’ data.
I feel that when the public starts to use this potentially
corruptible data on our roads, it will prove to be
dangerous. There’s going to be many maverick mappers
who will get a kick out of inputting data that will cause
trouble, not too dissimilar to hackers loading viruses onto
websites. Simply re-tracing main road traffic into difficult
and potentially dangerous situations, will be child’s play.
I, for one, will only trust commercial data in such a
context. You never know what you’re driving into when
using ‘Map Share’ data, and there’s no ‘Quality
Assurance’ from errors.

A: My own view is that, despite what we might like to
think, maps (of whatever type and media) are only
created for a user (and sometimes the creator and the user
are the same person). It is therefore necessary for us, as
cartographers, to persuade the general user community
that they can have (and sometimes create for themselves)
good quality representations, and that they don’t have to
put up with poor data quality, poor design and poor
presentation. I think that even the average punter can
determine the difference between a good quality map and
a bad quality map, and if enough people are shown that
the cartographic community is committed to good quality,
we can ensure our survival, indeed our prosperity. Quality
here refers to content, compilation, design and layout,
platform and usability (and further things) – all areas in
which cartographers have expertise.

Q: I am writing a piece for the Google Earth Design
blog and am talking about design choices. I am
mentioning the concept of mouse rollover enlargement
of detail on the fly. For the life of me I can’t remember
where I saw this used and have looked in vain via web
searching. Could anyone point me to a site that uses
this concept?

A: You’ve probably already seen it, but Ed
MacGillavray’s site has examples of all sorts of ‘widgets’
like the enlargement one: http://www.webmapper.net/
maps/navigation/index.php

A: Multimap has a mouse rollover where you can set the
map as a ‘hybrid’, with the aerial photograph on top of
the map base. As you move the mouse over the aerial
photo the underlying map detail is shown. 

A: Possibly, this (non-map) site, with a workable
magnification scheme, might lead you to helpful
information: 
http://www.rolandlee.com/product_Oxen—
Festival-of-the-West_94_89.html

Q: Can anyone point me to a good (ie free!) online
source of simple pattern fills suitable for use on maps
prepared with Inkscape, which uses .svg files?
Hatching, cross-hatching, stipple, etc in various grades
and densities?

A: Illustrator comes with many (which may be exported
to svg) – check their “Cartographic” library, and I think
they have others with hatches, etc. If you don’t have
Illustrator, perhaps someone that does can export them for
you. 
Also, MapPublisher Demo (free) includes many as well
which can also be exported to svg.

Q: Currently we have a Thales Mobile Mapper CE, a
non-industry standard application which can produce
high quality maps. However, these maps are not
compatible with the industry standard applications.
This causes issues when clients who want to overlay
our maps onto their own drawings. tcm propose to
resolve the solution by using the industry standard
applications eg AutoCAD light. Can you recommend
something on the market that would meet our current
and future needs?

A: I would suggest MapInfo Pro rather than AutoCAD.
MapInfo is a GIS system with the built-in universal
translator so it would be easy to get your data in and out
to other applications (including AutoCAD). Also it is not
a costly as ArcGIS, probably the other main alternative.
MapInfo can maintain not only the graphics, but also the
geodetic co-ordinate system and unlimited attribute
information (e.g. names, codes, dates, etc in a spreadsheet
linked to the objects). I think that neither of those is so
easy in AutoCAD.

A: DNR Garmin is
(http://www.dnr.state.mn.us/mis/gis/tools/arcview/
extensions/DNRGarmin/DNRGarmin.html)
probably the best GPS Software Utility for consumer
grade equipment, and it is free. It will integrate with
ArcMap, transfer your Garmin data into shapefile, match
tracklog points to digital photos (georeferenced photos!)
and much more.
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Q: I was wondering if anyone is able to help with a
problem with Illustrator 10? We produce among many
things, posters which look really good with a drop
shadow effect around text/objects. However, when we
print out the artwork, white or light coloured boxes
appear round the text/object to which we have applied
the effect. We work on AppleMacs if this has any
bearing on the problem? Any suggestions gratefully
received.

A: I think you might find the solution in the “Document
Raster Effects Settings” dialogue (Effect->Document
raster effects settings). Make sure the Background is set
to Transparent and the Create Clipping Mask is NOT
checked.

Q: Ordnance Survey UK have been supplying small
scale and derived data products in NTF
(National/Natural Tranfer Format) since 1988, since
1992 as NTF2 to BS7567. Initial informal
investigations show that most users then transfer the
data to Shape or Mid/Mif files for use in their GIS
applications. Are there any users of the forum who
would have difficulty if Ordnance Survey switched
supply from NTF to Shape and Mid/Mif files? And are
there any who would prefer it supplied in this format?

A: We get 250k topo update data every year in NTF for a
major road atlas project, and have written programmes to
extract attribute and geometry data to feed into our own
mapping software, not ARC or Mapinfo. Although we can
read shape and mid/mif files, we would still need to do a
fair amount of work to establish procedures for extracting
the attribute data in the right format, not a major technical
problem, but still a cost to be borne.
Does this mean that OS is wanting to abandon NTF? If
so, why adopt proprietory file formats for small scale
data, when they clearly aren’t suitable for large scale
(otherwise why Mastermap)? Surely the time is almost
here when all small scale data are derived directly from
large scale, using standard filtering and generalization
algorithms – in the public domain (and pigs will
definitely have wings – which is not to say that they’ll be
able to fly).
Sorry – couldn’t resist. I was never convinced that NTF
was much of an improvement on the original OSTF data
format, just more complicated and invented by a second
generation. I suspect that much the same applies to
Mastermap.

A: We would also prefer the supply of shape files, as it
cuts down on any possibilities for corruption or error in
conversion (rare, but they do happen occasionally)

A: As a County Council, we would be delighted to
receive the data as Shape files rather than having to
convert from NTF. Anything to save time and the
possibilities of error in the conversion.

Q: I am new to the world of GIS and have just
completed an introductory on-line course. My usual
workstation is a Mac using Adobe Illustrator and I
wondered if anyone could advise me as to whether
MAPublisher is necessary/recommended or not since I
have access (in my office) to a PC with Arc GIS on it?

A: I would say no as you can export layered Illustrator
format files directly from Arc GIS.

A: While I am not working on a Mac myself, I know
many of my colleagues do. Many are also using
MAPublisher.  I would suggest checking with CartoTalk
(http://www.cartotalk.com).

A: In answer to your question I would say it depends on
what you want to do within Illustrator.
1. Work in the GIS and then export the finished map into
Illustrator to tidy it up.
2. Import georeferenced data into Illustrator with all
attributes present and editable.
If you know it will only ever be option 1 then there is no
need to get MaPublisher but if there is a chance you may
need to follow option 2 then you will need the software.
Sometimes I will process data in ArcGIS, export out as a
shapefile and import into Illustrator to create the map.
Most of the time I import into Illustrator from the start
and create the map from scratch. 
Other people may disagree with me. This is how I work.

A: There are two different workflows for finishing GIS
mapping in Illustrator:

• Use MAPublisher to work with shapefiles directly in
Illustrator, using MAPublisher’s facilities for any
selection, analysis, combination, or other
geoprocessing.

• Do the heavy work of geoprocessing in ArcGIS, then
export an Illustrator file for graphic finish work on the
Mac. 

I think that most of my US colleagues and I now
primarily use the second method. This one-way workflow
does require some intellectual rigour, as one must
remember to do all the geoprocessing at the beginning of
the process. One cannot decide in the finishing stage to
include more territory, use a different projection, or use
different statistical class breaks.

A: Yes ArcGIS does indeed export Illustrator format but
in so doing you would lose ALL geospatial information
(co-ordinates, projection, attributes etc.). Whereas if you
use MAPublisher and import all your GIS data directly
into Illustrator all the spatial information is preserved and
usable within the Illustrator environment.

A: I’d modify that to say it depends how strong your
mind-meld is with AI. I’ve been Freehand/AI all my
career, and so that’s what I know how to think visually
within. Having attributes available in Illustrator to do
basic sorting/layering, labeling and symbolization
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functions works great for me. But clearly Arc 9.2 has
reached the point where you can do those basic functions
there as well, then exporting to AI as someone suggests.
So at this point I’d say it depends on where you are
starting from and what your internal data/graphics flow is.

Q: InDesign… aaargh! Illustrator… aaaaaaaargh!!
Photoshop… OK, you got me there!!!

A: Sounds like a bad day at the office, hope the
following helps [with apologies to Kipling]:

IF you can save your files when all about you
Are losing theirs and blaming it on Microsoft,
If you can trust your data when all men doubt you,
But make allowance for errors at the survey stage;
If you can wait and not be tired by waiting, however

long the spinning wheel of death revolves
Or being spammed, don’t deal in spam,
And yet don’t look too good, nor talk too wise:
If you can dream – and not make an iphone your master;
If you can upgrade – and not make upgrading your aim;

If you can meet with InDesign and Quark Express
And treat those two competitors just the same;
If you can bear to see the map you’ve slaved over cut ‘n

pasted cheaply on the PowerPoint screen,
Or watch the Freehand you gave your life to, broken,
And build your skills around the Illustrator theme:

If you can talk with crowds at Summer School,
Or walk with Committee – yet not lose the common

touch, if neither foes nor loving friends can hurt you,
If both SoC and BCS count with you, but neither too

much;
If you can fill the unforgiving minute
With sixty seconds’ worth of digitising done,
Yours is Google Earth and everything that’s in it,
And – which is more – you’ll be a Cartographer, my son!

A: I gather you’ve unwrapped your copy of CS3. Stick
with InDesign – it does get better, honest!
As a recent CS3 (and particularly Illustrator) convert, a
few things puzzle me though:
Why, when Adobe trumpets its unified interface, do all
three applications have widely varying typographic
controls/panels.
How on earth do you control the corner radius of rounded
rectangles in Illustrator? The Help system suggested I do
this through the general preferences – which isn’t much
use when you’re just playing to get something to look
right.
InDesign’s preference-panel-dock-thing’s insistence of
only keeping one window/panel open is getting rather
tiresome.
Other frustrated FreeHand converts are welcome to
contribute “How on earth do you… …in Illustrator”
items.

A: I may have taken early retirement 2 years ago but I
seem to remember that you simply double click the

rounded rectangle symbol in the toolbox. This gives you
all the commands you require.

A: I remembered that from my previous affair with
Illustrator, but this doesn’t work in CS3.
Another suggestion has been: Draw a rectangle and Effect
—> Stylise ——> Round corners and change the number
and tick preview box on and off, which seems to work
with the “next” rectangle you draw, not the
current one, and produces weird results if you apply it
more than once...
Oh! for the simplicity and flexibility of FreeHand’s
Object panel.

A: Rounded rectangles are only adjustable while they are
being created. Once they have been created you can’t
change their settings but there is a way around that. Make
a normal rectangle and then go to Effect menu >Convert
to shape > rounded rectangle. You can then access the
settings through the appearance palette/panel by double
clicking on rounded rectangle in the list [covered in
recent SoC Illustratorworkshop – ED].

A: If you wish to create the rounded corners visually and
not to a specific radius, whilst drawing a rounded
rectangle, use the up and down arrows before releasing
the mouse button. Same for the polygon tools – adjusts
number of sides.

A: If it is something that you would use routinely, it
would be a rather straight forward plugin to develop.

Q: (following up the last one): Thanks to all who
responded to my earlier cry from the heart;
especially the poem. Some have (incorrectly) assumed
that I have upgraded to CS3. No not yet although I
was planning to. I have survived the upgrade to
Leopard (just) although it took 30 hours to rescue
data in target Firewire mode from a damaged hard
disk (sorry Apple you let me down, you let your
customers down, but most of all, you let yourself
down…)
As a Freehand user of 15 years, I just find it so
frustrating that Adobe seem to make a mountain out
of what Aldus and then Macromedia managed to do
inside the proverbial molehill.
What is particularly frustrating is receiving Illustrator
files from ArcGIS where every object sits on its own
layer and that layer is called “Group”. There must be
over a thousand layers in each of these maps, all called
“Group”. Try finding the island of St Helena in that
lot!
When I try to drag a box over the item I want to
select, the thing immediately moves a load of objects
from other layers that I can’t see.
Is it just me or is there an easy way of switching off or
locking every layer at the same time like in Freehand
when “Option-click” gives you control over your
layers palette?
I could go on... 
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A: Click on the tool and instead of drawing the rectangle,
just click where you want to draw the rectangle and you
can enter the dimensions and corner radius.

A: If you are having such a hard time struggling with
receiving Illustrator files from ArcGIS, why not try
MAPublisher? With MAPublisher you can easily and
effortlessly import shapefiles and other GIS data formats
directly into Illustrator and in so doing maintain all
geospatial information and the complete attribute
structure. See http://www.mapublisher.com for details.

A: Use Alt click on either the Visible or Lock column.
That will do all at once.
I also find it a good thing to change the Layer Palette
preferences to switch off the preview icons and to show
top layers only.
Use MAPublisher in order to import ArcGIS data in a
sensible fashion – i.e. one layer per Arc data layer,
keeping all the attributes and geographic co-ordinate
system, etc. Then you could run a query to find St
Helena, for example.
I think you will soon find Illustrator is actually better than
Freehand. I especially hated the text boxes in Freehand
and the fact that it moved selected objects to another
layer if you had something selected and accidentally
clicked on another layer in the layer palette. In Illustrator
you move things from one layer to another by clicking
and holding down to drag the small coloured square on
the right on the layer palette. The circle icon is a select all
in the layer button.
The appearance palette is very useful – e.g. when doing a
motorway you used to need three layers, one for the
casing, one for the fill and one for the centre line. Now
you just need one as you can give one line three different
strokes in the appearance palette. Also the symbols,
graphic styles, text styles, etc. All work very well with
MAPublisher style sheets to let you create a template that
can then be re-used for each new map.

A: The circle icon will select everything on a layer but its
purpose is for selecting a layer appearance. The correct
way to select the whole layer is by clicking to the right of
the circle. The small square indicates that NOT all objects
on that layer are selected, while a larger square indicates
that everything on the layer is selected. This is the same
for groups too.

A: Or for CorelDraw (any version going back 15 years)
where you just grab a corner node with the node tool and
drag it in or out from the corner to adjust corner radius
interactively at any time.
On the last few versions you can also do this
asymmetrically if you want trendy boxes with one or two
corners radiused and others square, for example).

A: Quite – FH can also easily achieve this. I know there’s
a steep learning curve with any new application -
especially for those useful, but undocumented shortcuts –

but I have been shocked at how the “leading drawing
application” can make simple stuff so complex. As others
have said, Illustrator seems to have gone backwards in
terms of ease-of-use with the last few versions.

A: Are you not confusing ‘Groups’ with ‘Paths’ ? Or
maybe you are exporting from ArcGIS as ‘eps’ rather
than ‘ai’. I often export Illustrator files (ai) from ArcGIS9
(at 2500 dpi to retain full accuracy) and normally each
shapefile layer comes into Illustrator as a separate layer,
retaining their original layer (shapefile) names. Within
this layer there should be 2 sub-layers called ‘Group’ the
first one is empty the second one contain the ‘clipping
path’ followed by ‘paths’ (every object is a path which
can be made visible/hidden, locked/unlocked). Be aware
that each layer exported from ArcGIS comes as a ‘clipped
mask/compound path’, this means all map objects are
initially grouped together with a invisible bounding box
(it can be seen if you use outline mode from View menu).
If you wish to edit the shapefiles, the first step is to select
the map features of each layer (using the Selection Tool
arrow) then use the Object menu to ungroup them using
the Release clipping mask or compound path command.
After this each map object (eg St Helena) can be selected
for editing etc. Make sure only the layer you are working
with is unlocked, also utilise the Direct and Group
selection arrows for more flexible selection options.
Using the Control and Alt keys (may differ on a Mac)
allows multiple or single layer selection to view or lock
layers.
Looks like an SOC or Summer School course on working
with GIS files in Adobe Illustrator may be required for
freaked out former Freehand users. Once you start
working with complex shapefiles (eg polygons with
islands or ‘doughnuts’) there are many other issues to
resolve. Investing in a copy of Avenza MaPublisher for
importing geo-referenced ArcGIS shapefiles with
attributes etc would give you more options (eg select by
attribute) than directly exported non-georeferenced
Illustrator files without attributes (though this is initially a
cheaper and simpler method).

A: I have done a few tests with this and as 10,000 dpi is
the max I’ve heard Arc exports I choose to go with 7200.
Reason being as a multiple of 72 (which is the dpi
Illustrator works in – 72 postscript points to the inch) it
seems to eliminate rounding errors better in my
experience and doesn’t seem to effect performance if you
are talking vectors. 
I really hate the fact arc called this setting resolution and
labeled it dpi as most users I come across find it
misleading and don’t realize what it’s doing to their
vectors.
Note that if you have any rasters or transparancies in the
Arc file you won’t want to work in these high output
resolutions, and I think they come through in RGB as
well-rasters should be exported seperately and combined
in Illustrator.
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Q: I have a problem, maybe someone can help ... I
have over 30,000 (seriously!) Illustrator files saved in
Macintosh version 8.0 ... and, of course, to open them
in my Mac version of CS2 or CS3 involves a whole set
of dialog boxes to update the fonts — about 1-2
minutes for each file. I once figured out how long it
might take me to update all the files one at a time, it
was like half a year, working everyday for 8 hours
(with a 1/2 hour lunch). Does anyone know how to
update Macintosh Illustrator 8.0 files in batches?

A: A simple Applescript can do wonders. 
This script will open a file in CS3:

do shell script (“open -a

‘/Applications/Adobe\

Illustrator\CS3/Adobe\

Illustrator.app’/yourFile.ai”)

This applescript hits the enter key:

activate application “Adobe Illustrator

CS3”

tell application “System Events”

delay 1

keystroke return

end tell

Q: While we are on the subject of problems with
Illustrator, when I started using the program I was
able to resize objects and groups by dragging a corner
just the way I used to in Freehand. I don’t know what
I’ve done but now it will no longer allow me to do this.
I’ve been through all the preferences and double
clicked all the buttons but can’t find anywhere to set
this up. However Illustrator on my colleagues
machines works just the way it used to on mine.

A: View>Show Bounding Box or CTl+Shift+B

A: Likely you hit “shift-command-b” by accident. Hit it
again to re-enable the feature.

A: The only way I could reproduce the problem you
described is by using the open arrow select tool (the one
on the upper right side of the tool box) to try to drag the
corner of the object(s) instead of the solid arrow select
tool (the one on the upper left side of the tool box). With
the open arrow, if one tries to drag on the corner to
enlarge the object, it simply moves the object in concert
with the arrow. If you have this turned off then when you
click on the object, the bounding box appears.

A: Firstly you need to be using the Selection tool which is
the black arrow (not the white arrow-direct select tool).
Also make sure you have Show bounding boxes selected
which can be found half way down the View Menu.
If that is not the problem then I think you may need to
take slightly more drastic action and delete the AIprefs
file. Best to search for it as it will be in a different place
depending on the software version and the operating
system.

A: Go to ‘View’ and draw down to ‘hide/show edges.
Your bounding box to multiple selected boxes will now
appear.

Q: Whilst everyone is busily brainstorming alternative
workflows, here’s a problem I’m going to come across
soon…
We prepare student photo sheets of our current
students. We deal with literally hundreds of students,
probably thousands. They are laid out with a photo
plus name and other details. As students frequently
join, leave and change courses these need to be pretty
dynamic – the photos and names are frequently
moving around the page.
Until now we’ve been doing this in FreeHand; I
daresay Illustrator is equally capable (because of the
frequent changes I think a drawing application is
better than something like InDesign). I haven’t yet
found if Illustrator gives you the precision in placing
guides that FH gives, and how we deal with multiple
pages – but we’ll cross those bridges when we come to
them.
One big problem is capturing the names data. It exists
in an Excel file, but cutting and pasting into FH or AI
gives the names in one large text block – meaning
multiple cut & pastes either from Excel or within the
drawing package. However, if the text block is pasted
into a FreeHand 8 document (running under Classic),
exported as a FH3 (!!) document, and then re-
imported into FH8 I get a whole series of discrete text
blocks (terminated by an ‘end-of-paragraph’) – ie
each name from say 250 cells of Excel data is in it’s
own text block. FAR easier to layout on the page.
As Classic is lost with OS X 10.5 Leopard, any other
workflow suggestions would be most welcome.
And before any wag suggests “get a Windows
machine” – yes, we’ve considered that, but can’t get
hold of a (legal) copy of Windows FH8. 

A: This sounds to me like a relational database project.
Filemaker would do this pretty easily, as I am sure would
MySQL or Access.

A: You could look into Indesigns Datamerge. Also do you
know that you can link Excel spreadsheets to InDesign so
when the spreadsheet changes the content will change?

A: I found a wealth of scripts an plug-ins for Illustrator
on this page:
http://www.kelsocartography.com/scripts/
Divide Text Frame and/or Join Text Frame might solve
your particular problem. Haven’t tested the though.

Q: I am using ArcGIS and VMS data (Vessel
Monitoring System) from fishing boats operating
around the north-west coast of Scotland (=ICES area
VI) for my work GPS signals and the cresponding
date & time are transmitted within a certain period of
time (2 hours or less) from the boats.
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The GPS signals come in WGS 1984. The resulting
boat tracks and the athymetry map I am working with
are in WGS 1984 and Mercator projection with
Standard Parallel 55.
I found out that the measured distances on the
bathymetry map are not crrect (so the boat distances
can’t be assumed to be correct as ell), although the
distortion with a set Standard Parallel of 55 for my
area shouldn’t be that big.

E.g.
Correct: My value:
44918m 49159m
372838m 390584m
19587m 21984m
95366m 104445m

Of course, the error of hand measurement has to be
taken into account, but still the discrepancy is very
big.
I do need the correct distances for my work, so my
question is, why are the distortions so high, and is
there an explanation/solution for this problem?
Is it possible to re-project my map and tracks into
another projection in ArcGIS, so the distances are
then correct?

A: There is no projection where all distances are correct
in all directions. For that you need the globe.
The Mercator projection does not have standard parallels
as such. The equator is in effect the standard parallel. By
saying you have a standard parallel of 55deg or whatever
I assume this means that the nominal scale of the map is
stated for this particular latitude, but the scale of the
Mercator projection varies with latitude. Traditionally
navigators have overcome this by using the latitude scale
on the edge of the chart, i.e. they use dividers to measure
a line and compare this with the latitude at approx the
mid point of the line, not with a scale bar for the whole
map. This takes into account of the variation of scale with
latitude.
In a digital environment, what you need to do is apply
appropriate scale factors to your distance calculations
depending on the the latitude. I would have thought there
must be some way ArcGIS would give correct distances,
but have not investigated this. 
The Lambert Conformal Conic with the appropriate
standard parallels may give closer to correct distances
without complicated maths.

A: It could be that you have imported the data from a
spreadsheet or database table into a feature class/shapefile
that has the wrong Geographic Coordinate System
settings.
The GPS collects points using the WGS84 coordinate
system. This has the WGS84 datum and would record the
points/lines in decimal degrees, unless you used the GPS
to record the points/lines in another GCS such as British
National Grid.
In Arc you would need to import the data into or create a
feature class/shapefile in ArcCatalog that matches the

Spatial Reference that your data is recorded in.
In ArcCatalog select the Spatial Reference from the
Spatial Reference Properties dialogue box during the
creation routine. If the data is WGS84 then select WGS84
from the Geographic Coordinate Systems.
You can then import your data into this file and it will be
in the correct place in the world.
If you want to reproject to another projection and datum
(such as Transverse Mercator or UTM) you can use the
project tool in ArcToolbox. Arc also allows you to import
data directly from a table or spreadsheet using the Add
XY Data tool from the Tools menu in ArcMap.
Here you have to select the data source and the GCS to
create an Events layer that can then be saved as a feature
class or shapefile later. Importing data into a file that has
a different datum to the one that the data was collected in
can give you large errors.

Q: Is there and equivalent to ‘Paste inside’ in
Illustrator CS2? I want to fill an irregular closed
shape with diagonal bands of colour which stop at the
edges.

A: Use a swatch and / or a graphic style. See the
MAPublisher Utilites for various existing styles including
cross hatching that you can adapt.

A: In the Object menu, there is a Clipping path option –
ensure you have the closed shape on top of the contents
when you “make” the clipping path.

A: Just make sure you don’t mind *all* your artwork
being moved to the clipping path’s (mask’s) layer. This
was a most unwelcome surprise the first time it happened
to me! 50 nicely defined layers munged into one! Ouch!

And finally:

Q: I was wondering what people’s views were on
cartographers transferring between various
cartographic specialisations and how easy such a
transition would be to make, in your opinions.
Say, (just for instance) a cartographer working for OS
for many years on topographic land mapping,
transfers into the UK Hydrographic Office, and then
has to learn the art of MARINE cartography.
Or another person moves from Air Charting to land
mapping.

How long would they take to get up to speed?
Have any of you made such job changes?
How did it go?
How long did it take to settle into new working
practises?
What were the hardest changes for you to adjust to?

Which areas might prove easy transitions, and which
are so specialised that it might be easier to train staff
from scratch rather than re-train existing
cartographers?
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A: I have changed cartographic disciplines on a number
of occasions in my thirty-odd year career. The answers to
your questions would vary according to the change. All I
would like to say is that however much new knowledge
has to be gained in the new job, the basis knowledge of
cartography is the essential thing. For example, in my
present job working in a property company, although
there was a lot of legal and other stuff to learn which took
at least two years to become competent at, it is far better
that the production of the maps is done by a cartographer
who has to learn about property than a property expert
who has to learn about cartography. I guess I’m really just
pushing the concern of us cartographers about others
taking over our work who do not realise what they don’t
know e.g. many GIS people.

In my experience, I would rather employ someone with
GCSEs in TD and geography, and a good eye for detail,
for datacapture work, rather than someone with a degree
in GIS. These days I am totally dependent on GIS and IT
trained staff and generally have great respect for their
skills. However, I’m not totally convinced that this
respect is always mutual.

A: Reply on two levels:
In my career I have made a couple of significant changes.
When I left college I had a qualification in cartography
(Oxford Brookes) and thought I knew it all. My first job
the Soil Survey of England and Wales soon proved this
not to be the case. The requirements for soil mapping
were quite specific and had to be learnt on the job really. I
would say that within a few months I was proficient in
this field, due to listening to the words of wisdom from
my supervisor as much as anything. I soon realised that
the work at the survey was somewhat limiting – being
essential repetitive and allowing little scope for
innovative work. At the time my peers all seemed to be
flocking to the oil industry – thinking that there was
money to be made there! I went the other way and moved
into University cartography. I found the challenge of
working for academic staff much more rewarding (and
significantly less well paid!), as they were always asking

for work in different parts of the world, required
compilations to be researched, at differing scales, and on
a really varied range of subject matter and formats. At
this time the biggest adjustment was from using
predominantly scribing techniques to predominantly pen
and ink techniques (remember Rotring finger!). On
reflection there was a limited opportunity to work in full
colour very often, due to academic outlets being
publication in monochrome books and journals, etc. As
time has gone on the job has involved less and less
production cartography and the challenge has been to
keep one’s carto skills abreast of rapidly changing
technologies (greatly aided by involvement in the Society
of Cartographers and its activities like the SoC Summer
school).

Secondly, I have serious concerns about people’s ability
to make the moves nowadays suggested by the original
posting. With the demise of cartographic education – and
I am talking from a UK perspective here, as that is what I
know best – increasingly folk don’t have the full range of
cartographic skills that would have previously been
provided by traditional cartographic training. I don’t
know how things work at the UKHO, but I suspect there
is a strong trend towards less “rounded” cartographers
emerging. A classic example of this is the employment
policy of the UK National Mapping Agency (OS). On a
recent visit there we were introduced to some of the
workforce at their workstations. They were
predominantly teenagers, who we were informed had
been taken on from the local work-pool (off the street was
how someone put it!) and taught a particular skill at the
OS. They might be highly skilled aerial photo interpreters
or editorial checkers (onscreen) but how much did they
know of the bigger picture regarding the mapping
process? These staff might be able to make the jump to
marine cartography or air charting but only in the sub-
field that they had been trained in. Obviously they could
be re-trained in any new areas by their new employers,
but why should they do this rather than employ someone
already skilled in that sub-field.
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People’s Map British Isles Mini Atlas

The People’s Map 
LLP, 2007, 32 pages, ISBN 0955621402 £2.99 (pbk)

This new mini atlas of the British Isles is A5 size with 32
pages within a glossy, hardwearing cover. At the main road
level, it has the edge over the larger floppy road atlases
that clutter car back seats and shelves. With a scale of 1:1
million and one and a quarter million for Ireland and
central and northern Scotland, it includes motorways and
all main roads, although only selected ‘B’ category roads
(‘R’ category roads in the Republic of Ireland) are shown,
which arguably provide adequate detail when approaching
final destinations. The amount of detail given to place
names is appropriate for the given scales, despite the view
that adventurous motorists prepared to take short cuts to
named destinations along minor unshown roads could save
time!

The mini atlas is not just a road atlas, as relief is
shown with traditional hypsometric tints that render an
excellent topographic presentation, which is often lacking
in the larger-scaled formats of its competitors. Other
topographical detail includes rivers and their names, other
hydrographic and hydrological features, relief names, and
county boundaries. The naming of motorway service
stations throughout the network is a welcome addition. I
would have liked to have seen the Brecon Beacons and
Snowdonia named, however, as they are not generally
regarded as part of the Cambrian Mountain range. Also in
Wales, the Llanwrtyd Wells town point symbol seems to
have lost its name. The inside cover has the usual distance
chart associated with road atlases and a gazetteer features
on pages 26 to 32 with the reference squares clearly
identifiable on the maps, but a scale bar on each double
page spread would have been a useful aid. 

With the advent of community mapping, the People’s
Map Partnership may well provide the catalyst to more
ambitious publications and, eventually no doubt, a larger
scaled floppy road atlas will ensue with greater detail of
Britain’s road network. More information on the People’s
Map Partnership can be found at
http://www.peoplesmap.com.

BILL JOHNSON

www.peoplesmap.com

People’s Map Partnership
Getmapping/The XYZ Digital Map Company
[website behind the British Isles Mini Atlas]

This review compares the data in the previously noted
published atlas, and also looks at the specifics of the
peoplesmap system.

Firstly, in order to compare the products I have used
a real-world example of something that recently happened.
After a meeting (at the OS as it happens) I was travelling
back to London up the M3 motorway. The motorway was
completely snarled up and looking like being a poor
choice. So I took the option of using the parallel A33/A303
route from Winchester all the way to the M25 (because I
knew it). Imagine planning this decision with both the atlas
and the website as aids. The atlas wouldn’t have helped
much as the scale used makes the detail sparse. I would
glean no info on the extent of the urban areas like
Winchester and Basingstoke that I would go through
(affecting my speed), would struggle with road number
references to keep me on track (what is the road number of
the red route shown parallel to the motorway from junction
8 onwards?), and would apparently visit somewhere that
had recently changed its name from Hartley Wintney to
Hartley Witney. 

So, what of the web detail? The first thing I noticed
is that the default layer is the Getmapping imagery layer. If
you Switching to the Peoples Map layer, I immediately
thought, well I’d like a bigger display area than that. OK,
so you can zoom in and out and pan around, but it does
seem unnecessarily small. Most other map services are
larger and adjust their display to your available screen size.
By zooming in I can see that if I can last on the motorway
to the A34 junction (oops, no junction numbers!), I can
skirt round Winchester, and also that Basingstoke is mostly
bypassed. And hey presto, what I thought from the map
was going to be the A303 is in fact the A30. The data is
exceedingly sparse, for instance there are no places at all
named between Basingstoke and Egham. Moving on to my
own local area, the whole of the Borough of Enfield has
four main roads and two railway lines showing and a few
district names (including an incorrect Winchmorehill).
And yet if you pan down through North London you
suddenly come to a random area with more detail (roughly
from Wood Green to Camden). Zooming in on this you see
some ‘Sat-Nav’ styling emphasizing the routing
information, with road text sizes too large for their roads,
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